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This manual and the software described in it is Copyright ® 1991, 1992 by Bruce J. Beare. All rights reserved. You 
may not copy this manual or the software except for backup purposes.

No warranty or statement of fitness of use for any purpose is made.
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ShareWare Notice

PasteIt Notes is now (once again) shareware. Feel free to use the 
program for a week or so and then either erase it -- or send me a 
check for US $25.00 (or equivalent).  If you wish a distribution floppy
and a manual, send an additional $15 ($40 total).

Please also feel free to provide copies of the program (unmodified 
please) to anyone who wants it. You may also upload the full 
distribution to bulletin boards as you like. ShareWare distribution 
services and CDROMs may include the program in their collections 
-- but they must drop me a notice that they are doing so.

The following address is effective August 1, 1994.

Bruce Beare
17753 NW Lonerock Drive

Portland, OR. 97229

Introduction

PasteIt notes is intended to be used to replace those sticky yellow 
notes that many people have stuck all over the place. Just create a 
pasteit note and 'stick' it on your screen wherever you like. It will 
stay there until you move it or delete it (assuming that the PasteIt 
Notes application is running). PasteIt Notes will collect all of these 
notes and keep them in a single file. When the file is opened, all of 
the notes will be placed on the screen just as they were when you 
last saw them. You may rearrange the notes to taste (I prefer to 
switch between tiled notes and diagonal notes).
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System Requirements

PasteIt Notes requires system 6.0.4 or later. It may be run on all 
Macintosh models. Although PasteIt Notes will run with the finder, 
the use of multifinder (or system 7) is strongly recommended.

PasteIt Notes is system 7.0 studly. This means that PasteIt Notes:
• will respond to the required apple events
• supports balloon help
• is 32 bit clean
• is compatible with TrueType (also shows the outline fonts in 
outline format).
• supports publish/subscribe.

PasteIt Notes Icons

PasteIt Notes uses several different document types. Each 
document type has its own icon:

This is the PasteIt Notes application program. Double click on this 
icon to start the program.

This is the PasteIt Notes preferences file. Under system 6, it will be 
found in the system folder. Under system 7, it will be found in the 
Preferences folder (within the system folder). This document is used
to store various personal settings that you have set for PasteIt 
Notes. If this file is removed, a new one will be created for you.

This is a PasteIt Notes data document. You may use the PasteIt 
Notes application to create as many of these documents as you 
wish. Each document may contain many notes.

Double click on this icon to start up the application and to display the
notes inside the document file.

Hard Disk Installation

To install PasteIt Notes on your hard disk, simply drag the 
application icon (shown at the left) from the distribution floppy onto 
your hard disk. This file may be placed in any convenient place 
(your desk top, an applications folder, etc).

Starting PasteIt Notes

Before starting PasteIt Notes, be sure to read the section on system 
requirements and hard disk installation.
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When PasteIt Notes if first started, you should see a screen display 
similar to the one on the left. If you are using system 7, you may 
wish to turn on balloon help while you get the feel of the program.

PasteIt Notes has three main menus. Each menu has a number of 
commands (or hierarchical sub-menus).

The window is your initial note. Type some text into it and the use 
the mouse to select the text.

Your window should now look something like this. 

Next, use the font sub-menu (under the Notes menu) to change the 
font of the text to New York.. After changing the font, change the 
size to 18 point using the size sub-menu (under the Notes menu).

Your window should now look something like this.

The next step is to set the title of the window. Use the Set Note Title 
command (under the Notes menu) to display a dialog. Since you 
have some text selected, PasteIt Notes will assume that you wish to 
use that text as the name of your note. It will place the string in the 
dialog box for  you. Enter your new note title in the dialog box if you 
wish a different title -- then click on the OK button.

Use the New Note command (under the File menu) to create a 
second note. Type some text in it and set its title if you wish.
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Now, hold down the option key and use the Save All Notes 
command (under the File menu) to save all of your notes into a 
PasteIt Notes document file. Note, the Save All Notes command will 
not be displayed in the File menu unless you hold down the option 
key. 

You will be prompted with a standard save file box to enter the name
and the location of your notes file.

You may now Quit the application. You should find a your document 
file. Double-click on it to re-start PasteIt Notes. Your notes will be 
positioned just as you left them.

Setting your Note Preferences

Now that you have a little experience making some notes and 
saving them, it's time to personalize PasteIt Notes with your 
preferences.

PasteIt Notes has a easy to use and powerful way to remember 
your preferences for how you wish your notes to look. Click on your 
Hello World note that you made earlier. It is now the current 
(topmost) note. Change it's size to be taller and more narrow.

Next select the Set Note Defaults command (under the Notes menu.
This command will save all of the characteristics (note size, font and
size of the selection, window style, etc) of the current note. Any new 
notes that you make will have those characteristics.

Try the New Note command and then type some text into the newly 
displayed note. Notice that the text is displayed in 18 point New York
and that the note's shape is the same as the Hello World note.

PasteIt Notes 3.0 Preliminary Manual Page 8



PasteIt Notes 3.0 Preliminary Manual Page 9

Changing the Window Style

PasteIt Notes supports several different window styles. We will now 
change one of the notes to use the shadowed Box window 
style.Click on one of your notes and the select the Shadowed Box 
command from the Notes menu.

Your note should no longer have a grow box or a title bar. PasteIt 
Notes has the ability to move or resize such windows. Hold down 
the option and the apple keys simultaneously. Now while these keys
are still held down, position the mouse over the note.

The cursor changes shape when it is over the content region of the 
note. Hold down the mouse and drag the note to a new location.

The note can be resized in a similar way. Hold down the option and 
the apple keys simultaneously. Now move the mouse to the edge of 
the note. When the cursor has changed shape to a line or a corner 
bracket, depress the mouse button and drag the edge to resize it.

Using the Clean Up Command

PasteIt Notes has the ability to automatically re-arrange your notes 
for you on the screen. It can display them along either margin, along
a diagonal, or it can tile your screen with the notes.

Before using the Clean Up sub-menu, you should set the actions to 
be taken during clean up using the Clean Up Preferences command
(under the Notes menu). This command will display a dialog that is 
used to set up the behavior of the Clean Up commands.

Turn on all of the clean-up options for now. You will find a 
description for each option in the command reference section.
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Use the various Clean Up commands (under the Notes menu) to 
arrange your notes in different ways on the screen. Change the 
characteristics of one of your notes (text size/font, window size/style,
etc) and then do a Set Note Defaults command followed by a Clean 
Up command. Note that all of the notes have been altered.

You now have completed the basic tutorial for PasteIt Notes. The 
reference manual has detailed instructions for the use of iconified 
notes, power user preferences, the windows menu and many other 
commands.

The Apple Menu

Use this menu to open an item in the Apple Menu Items folder 
(system 7), a desk accessory (previous versions), or to see 
information about PasteIt Notes.

The About PasteIt Notes… Command

Use this command to display general information about PasteIt 
Notes and its author. The information will be placed in a new note. 
This note can be treated just like any other note -- except that it will 
not be saved for you if you don't modify it.

The PasteIt Notes Commands… Command

Use this command to display detailed instructions for using each 
PasteIt Notes menu command. The instructions will be placed in a 
new note. This note can be treated just like any other note -- except 
that it will not be saved for you if you don't modify it.

The File Menu

Use this menu to perform operations with files, notes and printers.

The Open Note File… Command

Use this command to open an existing note file (document). All 
notes in that note file will be displayed just as they were when the 
file was last used.

The behavior of this command is modified by the Multiple Files 
Open Simultaneously  check box in the Power User Preferences  
dialog box. If this box is not checked, the Open Note File  command 
will be dimmed if you already have a note file opened (even just an 
untitled note file). See the section Working with Multiple Note Files  
below for details on using multiple note files.
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The New Note File Command

Use this command to create a new note file (document).

The behavior of this command is modified by the Multiple Files 
Open Simultaneously  check box in the Power User Preferences  
dialog box. If this box is not checked, the New Note File  command 
will be dimmed if you already have a note file opened (even just an 
untitled note file). See the section Working with Multiple Note Files  
below for details on using multiple note files.

The Close Note File Command

Use this command to close an open note file (document). You will 
be prompted for whether you wish to save any changes.

The behavior of this command is modified by the Multiple Files 
Open Simultaneously  check box in the Power User Preferences  
dialog box. See the section Working with Multiple Note Files  below 
for details on using multiple note files.

The New Note Command

Use this command to create a new note. This command will be 
dimmed if you don't have an open note file (document). Use the 
New Note File  command to create a note file, or the Open Note File
command to open an existing one.

The behavior of this command is modified by the Multiple Files 
Open Simultaneously  check box in the Power User Preferences  
dialog box. See the section Working with Multiple Note Files  below 
for details on using multiple note files.

The Delete Note Command

Use this command to delete the current (topmost) note. If there are 
no visible notes, this command will be dimmed.

The Save Note Command

Use this command to save the selected (top most) note. The 
command will be dimmed if the selected note is not dirty.  A note is 
dirty when something about it has been changed since it was 
displayed (via Open Note File) or since it was created (via New 
Note). These changes include virtually anything that can be done to 
the note (changing the text, setting the font/size/style, moving or 
resizing the note, etc.). 

If you depress the option key while selecting the Save Note 
command, all dirty notes will be saved.
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The Revert Note Command

Use this command to revert the selected (top most) note to its last 
saved version. The command will be dimmed if the selected note is 
not dirty.  . A note is dirty when something about it has been 
changed since it was displayed (via Open Note File), since it was 
created (via New Note) or since it was last saved (via Save Note or 
Save All Notes). These changes include virtually anything that can 
be done to the note (changing the text, setting the font/size/style, 
moving or resizing the note, etc.). The selected (top most) note will 
be re-read in from the note file. All unsaved changes will be lost.

If you depress the option key while selecting the Revert Note 
command, all notes will be reverted.

The Export Text… Command

Use this command to save the current (topmost) note to a TEXT  
file. Such 'TEXT' files can be read via a variety of editors and word 
processors. This command is not available if you don't have a 
selected note. Note, formatting information is not saved by this 
command.

The behavior of this command is modified by the Export Text File 
Type  text entry area in the Power User Preferences  dialog box. 
You may use this preference setting to customize your export file 
type for your favorite word processor or editor.

The Import Text… Command

Use this command to import (read in) the contents of a new note 
from a TEXT file. TEXT files can be created by most editors, word 
processors and communications programs.

The Summarize Sub-Menu

Use this sub-menu to generate a note summary for any of several 
destinations (to the clipboard, to a new note, to a text file or to the 
printer). A note summary consists of the title of each note followed 
by the text in the note.  If Summarize To a Text File is selected, the 
file type of the resulting document can be customized for your 
favorite word processor or editor.  See the Power User Preferences  
command for information on how to customize the text file for use 
with your favorite editor.

The Page Setup… Command

Use this command to display a dialog box which allows you to set 
paper size, orientation and other printing options.

PasteIt Notes 3.0 Preliminary Manual Page 12



PasteIt Notes 3.0 Preliminary Manual Page 13

The Print Note… Command

Prints the contents of the current (topmost) note.

The Quit command

Exits PasteIt Notes. You will be asked if you wish to save any 
changed you may have made to your notes.

The Edit Menu

Use this menu to work with text or to undo an action. You may also 
use this menu to set preferences.

The Undo Command

Use this command to undo the previous operation. Nearly any 
operation that changes something about a note can be undone.

The Cut Command

Use this command to remove the selected text from the note. The 
text will be left in the clipboard.

The Copy Command

Use this command to copy the selected text to the clipboard.

The Paste Command

Use this command to copy the text from the clipboard into the 
selected note. The text will appear at the selection point.

The Clear Command

Use this command remove the selected text from the note.

The Select All Command

Use this command to select all of the text in the note.

The Create Publisher… Command

Use this command to create a publisher edition that can be used to 
share information with other applications.
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The Subscribe To… Command

Use this command to subscribes to a publisher edition that can be 
used to share information with other applications.

The Subscriber Options… and the Publisher 
Options…Commands

Sets options for your published or subscribed edition.

The Find… Command

Use this command to open a dialog box that may be used to search 
for a particular text string in a (any) note.

The Replace… Command

Use this command to open a dialog box that may be used to search 
and replace a particular text string in a (any) note.

The Preferences… Sub-Menu

The Preferences command will allow you to customize the behavior 
of PasteIt Notes.

Cleanup Options

Display a dialog box which allows you to select which note 
characteristics will be defaults when you clean up a note. The check
boxes in this dialog will allow you to customize the Clean Up 
commands. You may select the set of attributes for which you wish 
to have default values set for when you clean up your notes. The 
check boxes and their meanings are:

Default the window's font
Checkmark this box if you wish the 'clean up…' command to default 
the font for your notes.

Default the window's text style
Checkmark this box if you wish the 'clean up…' command to default 
the text styles for your notes.

Default the window's text size
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Checkmark this box if you wish the 'clean up…' command to default 
the text size for your notes.

Default the window's text alignment
Checkmark this box if you wish the 'clean up…' command to default 
the text alignment for your notes.

Default the window's tab setting
Checkmark this box if you wish the 'clean up…' command to default 
the tab setting for your notes.

Default the window's frame style
Checkmark this box if you wish the 'clean up…' command to default 
the frame style for your notes.

Default the window's size
Checkmark this box if you wish the 'clean up…' command to default 
the window size for your notes.

Default the window's colors
Checkmark this box if you wish the 'clean up…' command to default 
the foreground and background colors for your notes.

Make hidden windows visible
Checkmark this box if you wish the 'clean up…' command to make 
hidden notes visible.

PasteIt Notes 3.0 Preliminary Manual Page 15



PasteIt Notes 3.0 Preliminary Manual Page 16

Power User Preferences

Display a dialog box which allows you to select various options that 
will modify the behavior of other PasteIt Notes. The options and their
meanings are:

Export text file type is
Type in a four character file signature here. Exported documents will
be created with this file signature. The Export text file type field will 
allow you to select your favorite text editor or word processor to be 
used to view a summary or export text file. Some popular values for 
this field are ttxt for teachtext, QED1 for the QUED text editor or 
MSWD for Microsoft Word. This field must contain exactly 4 
characters.

Ask about note titles
Checkmark this box if you wish to be prompted to type in note titles 
for new notes.

Multiple Files Open Simultaneously
Checkmark this box if you wish to be have multiple note files open 
simultaneously. See the section Working with Multiple Note Files  
below for details on using multiple note files.

Show Full Titles
Checkmark this box if you wish to have the document name in note 
titles. For example if you have a note titled Phone number list within 
the note file Miscellaneous Notes, the title will be shown as 
Miscellaneous Notes:Phone Number list.

Show full Paths
Checkmark this box if you wish to have complete paths in note titles.
For example if the note file (from the Show Full Titles example 
above) is on your hard disk (named HD) within a folder named 
Applications ƒ, the title will be shown as HD:Applications 
ƒ:Miscellaneous Notes:Phone Number list.

Rainbow Color Notes
Checkmark this box if you wish to have rainbow colored notes. If this
box is checked, your newly created notes will be colored from a list 
of 256 possibilities. Not all color monitors can distinguish between 
all of the colors.

Preserve Note Ordering
Checkmark this box if you wish to preserve the ordering of your 
notes when a document is opened. If you choose this option, your 
note files may take a little longer to be opened.

Hide the note
Checkmark this box if you wish to hide a note when you click in the 
close box.

Delete the note
Checkmark this box if you wish to delete a note when you click in 
the close box.

PasteIt Notes 3.0 Preliminary Manual Page 16



PasteIt Notes 3.0 Preliminary Manual Page 17

The Show Clipboard Command

Use this command to display the a window that shows the contents 
of the clipboard.

The Notes Menu

Use this menu to perform operations on notes (windows).

The Set Note Title Command

Use this command to change the title of the selected note. If you 
have some text selected in the note, that text will appear as the 
proposed choice for the new title. If there is no text selected, the 
current note title will be proposed.

The Set Note Defaults Command

Use this command to set the attributes for all newly created and 
cleaned-up notes. All of the attributes shown on the Notes menu 
below the dotted line will be saved. Use this command in 
conjunction with the Preferences and Clean Up commands.

The Clean Up Sub-Menu

Use this Sub-Menu to reposition your notes or icons along either 
edge of the screen, on an angle (top left to bottom right), or to tile 
the notes (make them non-overlapping). When this command is 
used in conjunction with the Set Note Defaults and Preferences 
commands, you may re-set any of your note attributes to the default 
values.

Reset This Note's Defaults
Set the clean up attributes of the selected (top most) note to their 
saved default values. See the Clean Up Preferences command to 
select the set of clean up attributes.

Place Windows On Left
The notes will be placed along the left edge of the screen. When the
notes stack to the bottom of the screen, a new column will be begun
to the right of the first one.

Place Windows On Right
The notes will be placed along the right edge of the screen. When 
the notes stack to the bottom of the screen, a new column will be 
begun to the left of the first one.
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Place Windows Diagonally
The notes will be placed along a diagonal from the top left to the 
bottom right of the screen. When the notes stack to the bottom of 
the screen, a new diagonal will be begun to the right of the first one.

Tile Windows
The notes will be checkered on the screen starting from the top left 
and proceeding down. When the notes stack to the bottom of the 
screen, a new column will be begun to the right of the first one. This 
command will always resize the notes -- even if the CleanUp 
Preferences dialog does not have the option checked.

Place Icons On Left
The icons will be placed along the left edge of the screen. When the 
icons stack to the bottom of the screen, a new column will be begun 
to the right of the first one.

Place Icons On Right
The icons will be placed along the right edge of the screen. When 
the icons stack to the bottom of the screen, a new column will be 
begun to the left of the first one.

Place Icons Diagonally
The icons will be placed along a diagonal from the top left to the 
bottom right of the screen. When the icons stack to the bottom of the
screen, a new diagonal will be begun to the right of the first one.

The Font Sub-Menu

Use this Sub-Menu to select the font for the selected text of the top 
most note. Only the selected text will be changed. If all of the 
selected text is in the same font, it will be check-marked.

The Style Sub-Menu

Use this Sub-Menu to select the text style for the selected text of the
top most note. Only the selected text will be changed. If all of the 
selected text is in the same style, it will be check-marked.

Plain Text
Clears all styles from the current selected text. If there is no selected
text, the next character typed at the insertion point will be without 
styling.

Bold
Sets a bold style for the current selected text. If there is no selected 
text, the next character typed at the insertion point will be have bold 
styling. If all of the selected text is already bold, the bold styling will 
be cleared.

Underline
Sets a underline style for the current selected text. If there is no 
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selected text, the next character typed at the insertion point will be 
have underline styling. If all of the selected text is already 
underlined, the underline styling will be cleared.

Italic
Sets a italic style for the current selected text. If there is no selected 
text, the next character typed at the insertion point will be have italic 
styling. If all of the selected text is already italic, the bold italic will be
cleared.

Outline
Sets outline style for the current selected text. If there is no selected 
text, the next character typed at the insertion point will be have 
outline styling. If all of the selected text is already outlined, the 
outline styling will be cleared.

Shadow
Sets a shadow style for the current selected text. If there is no 
selected text, the next character typed at the insertion point will be 
have shadow styling. If all of the selected text is already shadowed, 
the shadow styling will be cleared.

Condensed
Sets a condensed style for the current selected text. If there is no 
selected text, the next character typed at the insertion point will be 
have condensed styling. If all of the selected text is already 
condensed, the condensed styling will be cleared.

Extended
Sets an extended style for the current selected text. If there is no 
selected text, the next character typed at the insertion point will be 
have extended styling. If all of the selected text is already extended, 
the extended styling will be cleared.

The Size Sub-Menu

The Size Sub-Menu may be used to select the point size of the text 
in the note. All of the selected text will be displayed in the selected 
point size. Menu items that are outlined are installed in the system 
file or are outline fonts. Items that are in plain text are scaled by 
quickdraw. If all of the point sizes are shown in outline form, the font 
is most likely an outline font (ATM or TrueType).

The size Other… command is used to display a 
dialog box that will accept any point size up to 255.

The Change Window Style Sub-Menu

This menu will allow you to change the style of window for the 
selected note. Four styles are available…
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The text in the standard resizable note will not wrap text at the right 
margin. It can be viewed by scrolling the window over. This note 
style has a close box, a zoom box, a horizontal and a vertical scroll 
bar.

The text in the resizable (no horz scroll) note will wrap text at the 
right margin.  This note style has a close box, a zoom box and a 
vertical scroll bar.

The shadowed box window style will wrap text at the right margin. 
This style has an additional method for moving and for resizing the 
note. Hold down the apple and option keys and drag a corner to 
resize this note type. Hold down the apple and the option keys and 
drag the interior (content region) to move the note.

The plain box window style will wrap text at the right margin. This 
style has an additional method for moving and for resizing the note. 
Hold down the apple and option keys and drag a corner to resize 
this note type. Hold down the apple and the option keys and drag 
the interior (content region) to move the note.

The Alignment Sub-Menu

The Alignment and Spacing Sub-Menu may be used to change the 
justification or the spacing of the text in the selected note. You may 
align the text to the left, the center or to the right. All of the text in the
note will be aligned to the requested setting.

The Set Tab Stops… Command

The Set Tab Stops Sub-Menu is used to control the tab expansion of
text that is typed or pasted into the note. If this value is zero, then 
tabs are not expanded (they are left as tabs). A non-zero value (of  
N) will cause tabs to be expanded to every Nth character position. In
this case, the tab characters will not be kept.

Note: if tabs are being expanded, the style information for any 
pasted text will be ignored.

The Foreground Color and Background Color 
Commands

If you have a color Mac, you will be able to change the colors of 
your notes. Use the Background Color command to change the 
color if the area on which the text is displayed. Use the Foreground 
Color  command to change the color of the text.

The Foreground Color command will change the color of the 
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selected text only.

The Windows Menu

Use the Windows Menu to show, hide or iconify a note. You can also
cycle through all notes.

The title of each note name may be preceded by any of three 
characters. The characters and their meanings are:

• The Bullet Mark The Note is Dirty
4 The Diamond Mark The Note is Hidden

The Check Mark The Note is Selected

The Cycle Windows Command

Use the cycle windows command to cycle thru all of your notes in 
turn.

The Show/Hide Notes Sub-Menu

You can hide your notes. A hidden note will remain in the file -- as 
well as in the Windows menu. To see a hidden note, either select 
Show All Notes, or select the note from the Windows menu.

Working with Multiple Files

If you use the power user preferences dialog box to select the 
Multiple Files Open Simultaneously option, you will be able to have 
two or more PasteIt Notes documents (files) active at the same time.
Each document may have many notes in it.

When more then one document is opened, several of the menus 
change. The New Note command, the Close Note File  and the 
Import Text command each become a hierarchical sub-menu. You 
can choose to create a new note in any of the opened note files. 
You can choose to import a text file into any of the opened note files.
You can also choose to close any of the opened note files. The N ⌘
and the K command are each assigned to the note file associated ⌘
with the active (topmost) note.

Moving and Resizing Notes

Notes may be moved and resized in ways other then dragging the 
title bar or the resize box. This method must be used with the plain 
box and the shadow box note styles.
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To move a note, hold down the apple and option keys while the 
cursor is in the center of your note. The cursor will change shape. 
When you hold down the mouse button, the window may be 
dragged.

To resize a note, hold down the apple and option keys while the 
cursor is on one of the corners or one of the edges of the note. The 
cursor will change shape. When you hold down the mouse button, 
the corner or edge may be dragged.

Command Key Equivalents

A⌘ Select All
B⌘ Bold
C⌘ Copy
F⌘ Find
H⌘ Hide note
I⌘ Italic
J⌘ Iconify
K⌘ Close Note File
N⌘ New Note
O⌘ Open Note File…
P⌘ Print Note…
Q⌘ Quit
R⌘ Cycle Windows
S⌘ Save Note (use the option key to Save All Notes)
T⌘ Set Note Title
U⌘ Underline
V⌘ Paste
W⌘ Delete Note
X⌘ Cut
Z⌘ Undo
>⌘ Larger
<⌘ Smaller
]⌘ Next Font
[⌘ Previous Font
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